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Warranty And Software Licence Agreement 

WestDev Ltd and Number One Systems 
This document contains the WESTDEV LTD SOFTWARE LICENSE AGREEMENT which will govern the use of the Westdev and/or 
Number One Systems' products supplied with it. 
You agree to the terms of this agreement by the act of opening the sealed package which contains the storage media on which the software is 
recorded. Do not open the sealed package without first reading, understanding and agreeing the terms and conditions of this agreement. If 
you do not agree to the license conditions you may return the SOFTWARE for a full refund before opening the sealed package.  
1. LICENSE AGREEMENT 
Ownership of the WESTDEV / NUMBER ONE SYSTEMS' Software Package and all its constituent parts supplied by Westdev Ltd 
("LICENSED SOFTWARE") is not transferred to the Customer. Westdev Ltd hereby grants the Customer a non-exclusive license to use the 
LICENSED SOFTWARE on a single computer workstation. Each computer workstation, even on a network, must have its own separately 
LICENSED SOFTWARE. 
2. OWNERSHIP OF SOFTWARE 
As the LICENSEE, you own the magnetic, optical or other physical media on which the LICENSED SOFTWARE is originally or 
subsequently recorded or fixed, but an express condition of this License is that Westdev Ltd and/or the copyright owner retains title and 
ownership of the LICENSED SOFTWARE recorded on the original media and all subsequent copies of the SOFTWARE, regardless of the 
form or media in or on which the original and other copies may exist. This License is not a sale of the original SOFTWARE or any copy. 
3. COPY RESTRICTIONS 
This LICENSED SOFTWARE and all accompanying written materials and all other constituent parts are the subject of copyright. 
Unauthorised copying of the LICENSED SOFTWARE, including software which has been modified, merged, or included with other 
software, or of the written materials is expressly forbidden. You may be held legally responsible for any copyright infringement which is 
caused or encouraged by your failure to abide by the terms of the License. 
4. TRANSFER OF LICENSED SOFTWARE 
The Customer may transfer the LICENSED SOFTWARE provided that (i) this Software License Agreement is transferred with the 
LICENSED SOFTWARE, (ii) the transferee fully accepts the terms and conditions of this Agreement, and (iii) all complete or partial copies 
of the LICENSED SOFTWARE, including copies on data storage devices are also transferred (or destroyed). 
5. MODIFICATION 
You may not otherwise modify, alter, adapt, merge, de-compile or reverse-engineer the LICENSED SOFTWARE, and you may not remove 
or obscure any Westdev Ltd and/or Number One Systems' Copyright or Trademark notices. You must use all reasonable efforts to protect the 
LICENSED SOFTWARE, diskettes, and documentation from unauthorised use, reproduction, distribution or publication, or otherwise in 
violation of applicable law. Please contact our Customer Service department if you become aware of violations of Westdev Ltd's Copyright. 
6. TERMINATION 
The License is effective until terminated. You may terminate it at any time by destroying the LICENSED SOFTWARE and all complete or 
partial copies thereof. It will also terminate if you fail to comply with any term or condition of this Agreement. You agree upon such 
termination to destroy the LICENSED SOFTWARE and all complete or partial copies thereof. 
7. WARRANTIES 
No warranties are expressed or implied with respect to the LICENSED SOFTWARE described, its quality, performance, accuracy or 
suitability for any purpose. In no circumstances will the copyright holder be liable for direct, indirect, incidental or consequential damages 
resulting from the use of this SOFTWARE. 
8. OTHER SOFTWARE 
The supplied disks may contain software whose copyright is owned by third parties. This license agreement shall apply equally to this 
software except where the terms of this agreement are specifically modified by the copyright holder(s). Such modification(s) will be included 
in a machine readable file on the supplied disks. 
9. GOVERNING LAW 
The Governing Law of this Agreement shall be that of England. 
Westdev Ltd will reward anyone giving information leading to successful prosecution regarding breach of copyright. 
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Chapter 1. Getting Started 
Installation 

Installation is via the autorun setup. If you are not familiar with this process it is 
explained briefly below: 

Insert the CD-ROM into your CD-ROM drive and wait a short time. The CD-ROM will 
run up to speed and an Easy-PC Welcome screen will appear. If autorun has been disabled 
on your computer you must execute the 'setup.exe' program using the Start menu and 
Run command from the Windows task bar. 

The installation is the same for new and existing users alike. Existing users i.e. version 
V3.0 to V10.0 can install V11.0 over an existing installation without deleting the old one 
first. 

With the installer running, once the Welcome screen is displayed, double-click on the 
Install Easy-PC For Windows - Version 11.0 option, or click then press Run. 
Following the instructions on the screen, you should use the same Destination Folder for 
the Program Files as your existing Easy-PC program files e.g. C:\Program Files\Number 
One Systems\Easy-PC 

All other instructions should be followed until completion. 

Click Finish to complete the installation. 

Running Easy-PC For Windows 11.0 

As with all Easy-PC programs, an icon will appear in the Number One Systems folder, 
you may also wish to create an Easy-PC Shortcut icon that sits on your desktop. 

To start the program, double-click on the Easy-PC icon from the Number One Systems 
folder. 
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Chapter 2. New Features in Easy-PC V11.0 
Introduction 

All features are categorised as being SCM specific, PCB specific or Both (relevant to both 
SCM and PCB designs). 

Star Points (PCB) 

Star or delta points are used in the design to connect two or more signals together at a 
common point. The significance is that the points retain their individual net names but 
then act as one connected net. This may be useful when a common ground source is split 
to create an analogue and digital ground as shown in the example below. 

 

 To use star points 
Star points are identified in the PCB design using free pads. On selection of a free pad, 
the Properties of the Pad will allow you to check the Star Point box, identifying its use 
as a star point. 

 
If on two separate nets for example, you add a free pad to each net and mark them as star 
points. When the two pads are overlaid to create one connection point and when DRC is 
run there will be no error produced. When plotted, the two overlaid pads become one with 
the two nets connected together. The two pads must be placed in coincident locations. 
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The illustration below shows the two star points before moving to be coincident. 

  
Below shows the star points after placement. 

 
Using <Shift> select will select all ‘connected’ star points at a given point. 

 Track routing rules 
There are some basic rules which must be followed in order for the star points to not have 
DRC errors: 

- Any star points used must be coincident (with the same X,Y positions). 

- Any tracks exiting the pads may only share the first track segment then they must 
separate. 

- Star points can be added to any pad style. 

Groups (Both) 

Groups are available in both Schematics and PCB. Any items can be grouped together. 
Once grouped, they can have an action performed on them, i.e. move, rotate etc. by 
selecting any item within that group 

Groups can be named; the name is also passed through from the Schematic to the PCB for 
use with options such as Apply Layout Pattern. 

Groups can be tight or loose (see below). You can use the Goto finder bar to find a named 
group. 

 Using Groups 
To group items together, select the items in the design and right mouse click. From the 
shortcut menu select Groups. The following dialog is displayed: 
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Tight Groups 

The items in a Tight group will remain in the same relative positions when you perform 
operations such as place, rotate, etc. In a loose (not tight) group, items are not locked 
together. 

 Ungrouping Groups 
Select the group in the design and from the shortcut menu, select Group> and Ungroup 
on the sub-menu. 

Component Bin Changes (Both) 

You can now do an extended multiple select in the Component Bin using the standard 
Windows key commands <Shift> or <Ctrl> and select. You can then drag the selected 
items into the design. They are added to the design as a vertical line of components until 
the mouse is released. 

 
Multiple selections in the Component bin can also be used in Apply Layout Pattern (see 
description later).  

You can also use cross-probe to select multiple bin items (using the <Shift> and <Ctrl> 
keys and selection). 



10   Easy-PC For Windows V11.0 Supplement  

Merge Shapes (PCB) 

The ability to merge shapes in PCB has been added to V11. The new Merge Shapes 
option is available for all closed shapes. 

 To merge shapes 
To merge shapes, select them first then from the context menu, select Merge Shapes, 

 
The resultant merged shape looks like this: 

 

Edit Symbol / Component In Library (Both) 

There are two new options available from context menu on selected components; Edit 
Component In Library and Edit Symbol In Library. These are available for single 
selected components in a design, allowing you to open the corresponding library item for 
editing. 

 
Once the item has been edited and Saved to the library, you must use Update Component 
from the same shortcut menu to reload it back into the design. 
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Dotted/Dashed Line styles (Both) 

Dotted and Dashed line styles are available in both Schematic and PCB editors. These 
line styles can also be used in Symbols. Use the Styles dialog from the Settings menu and 
Lines to edit or create new line styles. 

 
When editing a line style, the Pattern defines if the line is dotted or dashed; the default is 
a solid line. Note that filled shapes, board outlines and connected copper are always 
drawn solid, regardless of the defined pattern. 

The Dash Gap defines the gap between dots or dashes; the default is twice the width. If 
the pattern is dashed, then the dash length is also the gap size. For a long dash, the dash is 
twice this length.  

Note that you must use a named style to define a dashed or dotted line. 

Design Revision Analyser (Both) 

A new option has been introduced for comparing two designs of the same type 
(SCM/SCM, PCB/PCB and Project/Project) and reporting the differences. This allows 
you to compare two revisions of the same design to check what has changed. 

 
It will report on physical/logical differences between the designs. Physical differences 
include board area, copper area, track length, via count and via sizes. Logical differences 
are addition/deletion of components, nets and net contents. 
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This option is available on the Tools menu. 

 The checks made 

Design physical changes 
- area of 'major' board outline 
- count of top/bottom components 
Net physical changes 
- total area of copper shapes 
- total track length 
- via count (via pad style) 
Component physical changes 
- different footprint name 
- different pad style 
- different number of pads 
- component position/rotation/mirror/bin 
Net logical changes 
- adds 
- deletes 
- renames 
- node adds 
- node deletes 
- node changes 
Component logical changes 
- adds 
- deletes 
- renames 

 The design revision analyser report 
Two report types are available, standard text and an HTML format. The HTML option 
will produce a nicer looking report in a more clearly formatted page. 

Example HTML Report 

An example report written in HTML format might look like this: 
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Style Sheet 

When using the HTML report writing option, the report uses a style sheet to format fonts, 
font colours, styles etc. The standard template report.css is provided in the Easy-PC 
installation folder under the \Report Templates folder. This can be a user-editable file but 
we do not recommend it unless you really know what you are doing. 
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Shape Information Bar (Both) 

The new Shape Information Bar is available as a dockable bar to allow viewing and 
editing of the currently selected shape in your design. Shape coordinates, offsets and 
lengths can be edited for easy shape modification. 

It is available from the View menu and Dockable Bars> or by right clicking on the Easy-
PC furniture and selecting the Shape Information bar from the context menu. 

 
If the selected shape is edited interactively in the design window, the Shape bar will 
dynamically update to reflect the changing co-ordinate information for the shape being 
modified. 

The Rel check box allows you to display the coordinates in either Absolute or Relative 
units. 

When the Auto option is checked, this will cause the Shape bar to automatically switch to 
the most appropriate mode to display a selected shape, i.e. if a circle is selected it will be 
displayed in Circle mode. Polygon shapes will be shown in the most recently used of the 
possible modes. 

The Closed option will be automatically set to indicate whether the selected shape is 
Closed (unchecked means the shape is Open). The check box allows the state of the shape 
to be toggled between the two states.  

Modes available in the Shape bar 

The shape information can be displayed in various formats dependent on the current mode 
selected from the drop down list. When a different mode is selected the grid columns will 
reconfigure to display the chosen format. In all modes, shape points are shown as pairs of 
co-ordinates in adjacent X and Y columns in the grid. The various modes are described 
below: 
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Points 

The shape is shown as an initial Start Point and a series of Lines or Clockwise/Anti-
clockwise arcs to given points. For arc segments, the arc centre point is shown on the next 
row. The points will be shown in absolute or relative co-ordinates depending on the Rel 
setting. 

Point Offsets 

The shape is shown as an initial Start Point and a series of Lines or Clockwise/Anti-
clockwise arcs to given points expressed as offsets from the previous point. For arc 
segments the next row shows the centre point for the arc as an offset from the previous 
point. Only the Start Point will be shown in absolute or relative co-ordinates depending on 
the Rel setting. 

Segments 

The shape is shown as a series of segments starting from the given point with the given 
length and arc angle. The end point of the segment is given by the start point of the next 
segment. For the final segment of a non-closed shape there is an additional row showing 
its end point. The direction of arcs is given by the sign of the angle with a negative value 
indicating an anti-clockwise arc. The points will be shown in absolute or relative co-
ordinates depending on the Rel setting. 

Segment Offsets 

The shape is shown as a series of segments, similar to Segment mode, but with their start 
points expressed as offsets from the previous point. Only the start point of the initial 
segment will be shown in absolute or relative co-ordinates depending on the Rel setting. 

Circle 

If the selected shape is a circle it is shown as a Centre Point and a Radius.  For any other 
type of shape, the display will be blank therefore this mode is best used with the Auto 
option enabled. 

Rectangle  

If the selected shape is a rectangle it is shown as a Start Point and a Size; X = width and Y 
= height.  For any other type of shape, the display will be blank therefore this mode is best 
used with the Auto option enabled. 

Note that only orthogonal rectangles are recognised by the Shape information Bar.  

Editing Shapes in the grid 

You can edit shape segments, co-ordinates, arcs and lengths using the Shape bar. 

The shape values contained in the grid may be edited by double-clicking the mouse over 
the appropriate cell then typing the new value. The new value will be applied when the 
mouse is subsequently clicked outside the grid cell being edited or when the Enter key or 
one of the navigation keys is pressed on the keyboard. 

If a particular grid cell already has the keyboard focus (indicated by an additional dotted 
rectangle within the cell) it may edited simply by typing the new value without needing to 
click the mouse. The keyboard arrow keys may be used to navigate to other cells to 
continue editing. 

In Segments mode, a line segment can be changed to an arc by entering a non zero Angle 
value. For an anti-clockwise arc, enter a negative value. When using Points mode, the 
segment type can be changed by double-clicking then selecting the required type; 
Line To, Clockwise Arc or Anti-Clockwise Arc from the dropdown list. 
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Some values in the grid will not be editable, e.g. the start point of a track connected to a 
component pin, and as such will be shown as dimmed text. If a shape is Fixed, none of its 
values will be editable. 

It is not possible to make any edits in the Shape bar while a shape is being interactively 
edited. 

An edit that results in an invalid shape, e.g. a closed shape that self-intersects, will be 
reported and the edit aborted. 

Whenever a shape edit is performed in the Shape information Bar the design window 
will update to reflect the modified shape.  

Inserting and Deleting rows 

You can add or remove rows of a shape using options available on the context menu for a 
selected row. 

 

 To insert a segment into a shape 
Right-click the mouse over the grid at the point you wish to insert a new segment. From 
the popup context menu select the Insert Row item. A new segment will be inserted into 
the shape at that point. The exact position of the inserted segment will depend on the 
current Shape bar mode; in a Segments mode, the new segment is inserted from the centre 
of the existing segment to its end point. In a Points mode, the new segment is inserted 
after the end of the existing segment to the centre of the next segment (if there is one). In 
either case, the end point is gridded using a step size relative to the working grid. 

Insert Row is not available when using Circle or Rectangle mode. 

 To delete a segment from a shape 
Right-click the mouse over the grid row containing the segment you wish to delete. From 
the popup context menu select the Delete Row item. The way the segment is removed 
depends on the current Shape bar mode; in a Segments mode, the corner at the start of the 
segment is removed. In a Points mode, the corner at the end of the segment is removed. 

It is not possible to delete segments from a shape if doing so would cause it to become 
invalid. 

Delete Row is not available when using Circle or Rectangle mode. 
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Design Backup Files (Both) 

The new option, Design Backups will automatically retain the last ‘N’ copies of design 
files as you save.  Saving a design file will rename the existing file on disk as 
filename_BAK1.pcb for example, then save the open file as its proper name 
filename.pcb. Next time you save, _BAK1 becomes _BAK2, filename.pcb becomes 
filename_BAK1, etc. 

There is a new setting on the Preferences dialog on the General page that controls 
whether this feature is enabled, how many iterations / versions to save and where to save 
them. 

 
There is also a new option on File menu Open From Backup, this allows you to recover 
a backup copy of the currently open file, or any file on disk. 

 

Centre Alignment for Value Positions (Both) 

Value positions can now be centre aligned. Use the Properties dialog and Text page. 
Select Centre from the Alignment drop down list. 
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Reports (Both) 

The Custom Reports option on the Output menu has been renamed to Reports. 

Individual reports have been removed from Output menu and added to the Reports 
option. 

 
Track Analysis Report 

The new Track Analysis report reports on the ‘efficiency’ of track routing (track length 
verses minimum possible length spanning pads), see below.  

Delete Unused (Both) 

There is a new button on the Nets and Styles dialog named Delete Unused. This will 
remove all unused items in one go as highlighted below. 
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Design Calculators (Both) 

The new Design Calculators option on the Tools menu allows you to interactively run 
calculations on selected tracks and nets within the design. 

 
For more information and full documentation please refer to the online help. 

Rotate By command (Both)  

The new Rotate By command allows you to specify a rotation value in degrees for a 
selected item. This command is available on the shortcut menu and can also be assigned 
to a shortcut key if required. 
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Library Manager Changes (Both) 

Add menu changes 

The Add Package and Add Gate options have been removed from the Add menu. These 
options are both included in the Edit Package/Gate options are so made redundant. 

Edit Package/Gate changes 

The Edit Package and Edit Gate options on the Edit menu have been changed, when 
you click the Add button both now have previews of the Symbols. 

 
Properties of Package/Gate 

The Properties dialog on the View menu has Symbol previews on both the Package and 
Gates pages. 
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Fix/Unfix commands on shortcut menu (Both) 

The Fix and Unfix commands are now available on the shortcut menu for a selected item. 

 

Design Properties (Both) 

New inbuilt values are available to report design specific information. 

 Design Name - the name of the design (the file name minus the path and 
extension)  

 Author - the name of the author 

 Save Date - the date the design was last saved, useful for documenting the 
version of the design on a plot  

 Current Date - the date today, useful for documenting the date any print or 
plot was made  

 Layer Name - the name of the layer the position is drawn on  

 To use Design Properties 
To use one of the built-in design values, you must add a Value Position from the Edit 
menu to the component first. Once added, select it using a double click. This displays the 
Value Positions Properties dialog. 

 
Select the Value to Show from the list. 

Where Author is selected for example, the Value Name will be taken from the Design 
Properties dialog on the File menu and the Author: field as completed. 
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Select Ignores Fixed Items (Both) 

A new check box, Select Ignores Fixed Items on the Preferences dialog under 
Interaction has been added. This gives you the option to completely ignore fixed items 
when using select. Currently, if an item is fixed and it is selected, you get a warning 
dialog. Switching this new option on, the warning dialog will no longer be displayed, the 
selection will just ignore the fixed item. 

 

Goto (Finder) Bar Changes (Both) 

In Schematic, the Goto finder bar has been extended to include Error markers (as added 
by the new Design Rules Check option). Errors reported here are sorted by type and then 
by their ‘annotation’ (description). 

 
With the addition of the Group functionality in both Schematics and PCB, Groups can 
also be selected from the drop down list. 

Change to the Recent Files List (Both) 

The limit on number of files on the Recent Files list has been increased from 10 to 20. this 
value can be changed in the Preferences dialog and the General page. 
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Display Changes (SCM) 

In Schematic, there are new colour entries for display of Component Name Values and 
for design Errors. These are available in the Display dialog. 

 

Schematic Design Rules Checking (SCM) 

There is a new menu option on the Tools menu Design Rule Check. From the dialog, you 
can check across a Project, or on the current design using the options available. 

 
All rules in this dialog are described in detail in the online help under the Index heading, 
Design Rule Check (Schematic). 
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Auto Rename in Schematics and Projects (SCM)  

Version 11 introduces Rename Nets and Rename Components to the Schematic design 
editor. These options can perform renames on all sheets in a Project or on individual 
sheets. 

From the Rename dialog, with This Stem Only selected, the rename can be run on 
specific name stems within the design. If this is left unchecked, the Rename will be 
performed on all items using their original name stem but will rename them to be 
sequential removing all the name ‘gaps’. 

 

Auto Rename Nets in PCB (PCB)  

Auto Rename Nets is now also available in the PCB design editor.  

Track Analysis Report (PCB) 

This report, available for PCB designs, analyses the tracks in the design to estimate the 
'efficiency' of the track patterns.  

It is available from the Output menu and Reports dialog and displays an initial dialog 
from which to select Only Worse Nets and Output to CSV. 

 Worst : whether to see all the results for the nets, or only the 'worst' 10  

 CSV : whether to output the results as CSV or to a normal text report file  

 
The results produced by this report are grouped by the net 'type' which can be one or more 
of the following:  

 Point-to-point : two-pin net with direct track path between the pads  

 Multi-drop : net with three or more pins  

 Branching : net with three or more tracks coming off a node  

 Powerplane : net assigned to a powerplane layer  
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 Single pin : net with only one pad 

 No pins : net with no pads  

The results are written to CSV or report file, and contain the following amongst the values 
reported: 

 Track : this is the total length of track for the net  

 Tree : this is the length of the minimum spanning tree that connects all the 
pads in the net  

 Efficiency : this is the ratio of Track to Tree, giving a measure of how 'direct' 
the tracking follows the minimum possible path 

A design report might look like this: 

BRANCHING MULTI-DROP 
-------------------- 
        Net Name Pins  Vias      Track       Tree   Efficiency 
        ------------------------------------------------------ 
        NPRESET  5     0       2672.4843      1930.8071   0.72 
        OUTPUT   6     0       3426.0433      3017.5118   0.88 
        GROUND   6     1       2449.2638      2279.5276   0.93 
        ------------------------------------------------------ 
MULTI-DROP 
---------- 
        Net Name Pins  Vias      Track       Tree   Efficiency 
        ------------------------------------------------------ 
        B        3     1       1906.0630     1298.9843    0.68 
        +5Volts  4     0       3622.4921     2483.5000    0.69 
        ------------------------------------------------------ 
POINT-TO-POINT 
-------------- 
        Net Name Pins  Vias   Track          Tree   Efficiency 
        ------------------------------------------------------ 
        D       2     0       2141.4173      1110.1811    0.52 
        INPUT   2     0       2280.3583      1445.0354    0.63 
        FB01    2     0        570.7087       400.0000    0.70 
        FB02    2     0        570.7087       400.0000    0.70 
        FB03    2     0        570.7087       400.0000    0.70 
        FB04    2     0        550.0000       400.0000    0.73 
        ------------------------------------------------------ 
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Routing Areas Changes (PCB) 

Routing Areas can now designated as Keep In or Keep Out for tracks and vias. They can 
be changed in the Properties dialog. Both Easy-Router and Pro-Router now use this 
information. 

 
For the Routing Area Type, you can select to make Tracks and Vias Keep In, Keep 
Out or Unrestricted. 

 
Route Selected for Pro-Router 

On a selected net, the Autoroute option now uses the Pro-Router option if this is licensed. 
If the Pro-Router is not available, it will use the Easy-Router if licensed. 

Layer Toggling on Keys (PCB) 

A set of Layer Toggle commands are provided to allow the visibility of specific layers to 
be quickly toggled on/off. 

A set of sixteen 'Toggle Layer n' commands are provided, which by default, are not 
present on any menu but are available, via Customise , for assigning to a shortcut key, 
toolbar or menu. 
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By default, a particular Toggle Layer command will toggle the correspond layer in the 
defined layer order. For example, assigning the shortcut key Alt+3 to the command 
Toggle Layer 3 via the Keyboard page of the Customise dialog, will mean that the third 
layer, as defined in the Layers dialog, will be toggled on or off whenever the Alt+3 key is 
pressed. The defined layer order is also shown in the Layers Bar if displayed.  

It is possible however, to change the layer or layers to which a particular Toggle Layer 
command applies. Selecting Set Toggle Layers from the Layers Bar right click shortcut 
menu will display the Layer Toggle Setup dialog.  

The Layer Toggle Setup dialog 

This dialog shows all the available Toggle Layer commands along side a slot for 
specifying the layer to which each should apply.  

 
An empty slot implies the default association with corresponding layer in the layer order. 
Typing a specific layer name next to a particular Toggle Layer command will cause it to 
apply to that layer. Continuing the example from earlier, if "Top Electrical" is entered 
next to the Toggle Layer command 3 then pressing Alt+3 now will toggle the "Top 
Electrical" layer on or off.  

All Toggle Layer definitions will be saved and restored whenever the application is 
restarted and are independent of any particular PCB design.  

If layer names vary between designs it may be preferable to associate layers by 
characteristics rather than their explicit names. The format of recognised layer 
characteristics is: 

    <Layer Class> <Side> {<Index>} 
where <Index> is optional. 

So "Electrical Top" would always match the electrical layer on the top side regardless of 
whether it was named "Top", "Top Elec" or anything else, "Paste Mask Bottom" would 
always match the bottom paste mask layer if defined. Continuing again with the earlier 
example, if "Electrical Inner 2" is entered next to Toggle Layer 3, then pressing Alt+3 
now will toggle the second inner electrical layer in a PCB design regardless of what it is 
called.  

A Toggle Layer command associated with a unrecognised layer will have no effect.  
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When a Toggle Layer command has been associated with a particular layer it's command 
name will change to appear as a command for toggling that layer rather than the default 
'Toggle Layer n' command. In the example given earlier the command will appear as 
"Toggle Layer: Electrical Inner 2" rather than "Toggle Layer 3". 

 To toggle multiple layers simultaneously 
It is possible to specify more than one layer against a single Toggle Layer command so 
that a 'set' of layers are toggled when the command is used. Within the Toggle Layer 
entry, each layer definition should be separated by a comma. For example, Toggle Layer 
3 could be extended to be "Electrical Inner, Electrical Inner 2" which would toggle both 
inner electrical layers simultaneously.  

 To switch Layers on and off simultaneously 
Where multiple layers are specified for a single Toggle Layer command, it is possible to 
simultaneously turn some of them on and some of them off thus allowing 'sets' of layers to 
be visibly switched. To achieve this, any layer to be switched the opposite way to the first 
layer specified should be followed by the word "off". For example, defining Toggle 
Layer 3 as "Electrical Top, Electrical Bottom, Electrical Inner off, Electrical Inner 2 off" 
will allow the top and bottom electrical layers to be made visible and at the same time, the 
two inner electrical layers to be made invisible. Using the Toggle Layer 3 command again 
will have the opposite effect. 

Apply Layout Pattern (PCB) 

Apply Layout Pattern allows you to place and route sections of a design by matching 
with a previously placed and routed part of the design. This is very useful if your design 
contains a number of similar channels. 

The Apply Layout Pattern option is available from the Tools menu. 

 
Using Apply Layout Pattern 

Firstly, you will need a source for the pattern to be taken from. The source should contain 
some components. Where appropriate, tracks between these components will be included 
even if they are not selected. The source can be:  

 Selected Components - use the current selection as the source.  
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 A Named Group - create a group containing the layout pattern.  

 The Clipboard - use Copy to copy the layout pattern from the current design 
or another design.  

 A PCB Design file - select an existing PCB file.  

Secondly, you will need the section of the design the layout pattern will apply to. This can 
be:  

 All the components in the design.  

 Selected Components - use the current selection.  

 All the components in the Component Bin  

 A Named Group  

The matching process will match components according to their library component and 
connectivity, from this, nets will be matched, and then other components will be matched. 
Matching components are moved to the matching position and tracks between the 
matching components are also copied. Any components which do not match will remain 
where they are.  

A report showing which components matched can be produced by checking the Report 
Matches box on the dialog.  

 To use Apply Layout Pattern 
A typical process for using this option would be to create your Schematic design first. For 
a 3-channel circuit you would create three identical circuits with some inter-circuit 
connectivity, for power and ground for example. 

Each of the three channels could be grouped together and names Group1, 2 and 3 
respectively. The Schematic is then translated to the PCB layout editor and the 
components placed in the Component Bin. 

 
In the PCB design, add your board outline. Place the components from the bin relating to 
Group1, you can use the Goto, Group option to find this. Now route these placed 
components, this gives you a template for applying the layout pattern to into Group2 and 
Group3. 

Using the Apply Layout Pattern option, in the Take Pattern From: box select the 
Group radio button and select the Group1 name from the drop down list. 
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In the Apply Pattern To: box, select the Group radio button and select Group2 from the 
drop down list. Click the Apply Pattern button. 

The components and routing will be copied from Group1 to Group2 with Group2 now 
dynamic on the end of your cursor for placement. Place this and then repeat the Apply 
Layout Pattern process for Group3 using Group1 again as your template. 

This would be a typical process using groups as your reference but other methods can be 
used also. 

Integrity Check Changes (PCB) 

The Integrity Check option now reports all PCB only pins which are connected in the 
PCB but which do not appear in the Schematic. These are reported because they may have 
been connected in error; the report highlights these for you. 

An example report looks like this: 

Checking integrity of Schematic and PCB designs in project 
"Div". 
Ignoring PCB only pad U3.2 on net "CLK" 
Ignoring PCB only pad U3.3 on net "CLK" 
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Auto-mirror text when using change layer (PCB) 

For new text being added or existing text being moved from a Top layer to a Bottom 
layer, the text will automatically be flipped so that it appears Mirrored on the Bottom side 
and vice versa. 

Once text has been moved (and flipped) to the Bottom side, the text can be mirrored back 
to normal reading if required. 

This option is now Switchable via the Auto Mirror Bottom Text option on the 
Preferences dialog under PCB Interaction. 

 

New DRC Checks (PCB) 

Two new checks have been introduced into the Design Rules Check dialog for checking 
text on electrical layers existing outside the board outline and Track/Vias obeying the 
Routing Areas rules. 
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Plated/Non-plated status on board outlines (PCB) 

Board outlines can now be designated with a plated and non-plated status. 

A new Plated check box is available on Shape Properties for a Board Outline. 

 
Any Board Outline shape can be given this status so you should use it carefully. It is 
particularly useful for adding to board outline shapes used inside a main board outline to 
act as a cutout. 

Using the Plated status 

When plotting using the Plotting and Printing option, additional check boxes are 
available on the Settings tab to distinguish between Unplated and Plated board outlines 
when the Plot Board Outline check box is selected. 

  

Show All in Net Connections (PCB) 

In the PCB design editor, a new option (Show All) on the View menu under Net 
Connections is available to force display of connections on for all nets. 

 
This option would be used to show all the net connections after showing or hiding specific 
nets in the Nets dialog under the Show Connections column. 
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ODB++ Output Changes (PCB) 

The ODB++ output has been enhanced to enable composite power planes to be 
automatically produced. 

Where power plane layers contain track information, this can now be output automatically 
as a single ‘composite’ plane layer. 

 
The Output Positive Power Plane check box is used if you wish to output positive power 
planes as well as negative planes. 

The Composite Positive Power Plane check box is available if a power plane in the 
design contains embedded tracks. A single positive/negative plane layer is produced when 
this is checked. 

Layer Types 

You now need to specify the layer types to use for Silkscreen, Solder Mask and Solder 
Paste for output to the ODB++ matrix. This is required by the ODB++ format for use in 
the viewer. 
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